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Программирование в Maple
Создание процедур. Создание модулей, пакетов, 
библиотек. Работа с файлами. 

Создание графических приложений 
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Пакеты научных вычислений



Процедуры в Maple

➢Общие сведения о процедуре Maple
➢Полный синтаксис процедуры
➢Вывод кода процедуры на экран
➢ Локальные и глобальные переменные
➢ Работа с аргументами процедур
➢ Рекурсивные процедуры
➢ Вывод сообщений об ошибках, выход из процедуры



Общие сведения о процедуре, краткий 
синтаксис процедуры
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 proc_name:=proc (parameterSequence)

 statementSequence; 

 end proc;

Cлова, выделенные синим могут 
отсутствовать.

 

• Процедура – это пользовательская команда Maple. 
• Процедура может не иметь аргументов, иметь один аргумент или несколько 
аргументов (тогда они перечисляются через запятую). 
•  Все описание процедуры должно находиться в одной выполнимой группе 
(execution group). Переход на новую строку осуществляется с помощью Shift+Enter

Краткий синтаксис процедуры

• proc_name – имя процедуры
• proc … end proc – служебные слова, начало и конец процедуры
• statementSequence – последовательность выражений, реализующих тело      
процедуры. Возвращается значение последнего выражения (команды) из 
этой последовательности или значение выражений, указанных после 
команды return.



 proc_name:=proc (parameterSequence :: type) :: returnType; 
 local localSequence; 
 global globalSequence; 
 option optionSequence; 
 description descriptionSequence; 
 uses usesSequence; 
 statementSequence; 
 end proc;

Слова, выделенные синим, могут отсутствовать. 

Полный синтаксис процедуры

4

• parameterSequence – последовательность формальных параметров (аргументов) 
процедуры. Каждому формальному параметру можно предписать (декларировать) 
определенный тип данных с помощью оператора двойного двоеточия :: и 
следующего за ним названия типа данных type. При вызове процедуры в случае 
несоответствия какого-либо параметра его заявленному типу будет выдаваться 
системное сообщение об ошибке. Для параметров можно также задать значения по 
умолчанию.
• returnType – необязательный предполагаемый тип возвращаемого значения 
процедуры. По умолчанию, если тип возвращаемого значения не соответствует 
предполагаемому, ошибки не происходит.



Полный синтаксис процедуры (продолжение)
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• local – служебное слово для описания последовательности локальных переменных 
localSequence. Локальными называются переменные, которые используются только 
внутри данной процедуры. Для локальных переменных можно задавать тип в виде ::
returnType.
• global – служебное слово для описания последовательности глобальных 
переменных globalSequence. Глобальными называются переменные, которые не 
являются локальными, но также используются данной процедурой. Описание 
глобальных переменных используется в том случае, если этим переменным внутри 
процедуры будут присвоены какие-то значения. Для глобальных переменных 
нельзя задать тип внутри процедуры.

• option – служебное слово для описания последовательности опций процедуры 
optionSequence. В качестве опций используются специальные слова, например, arrow
(стрелка), builtin (встроенная процедура), operator (оператор), remember (опция 
для эффективной работы рекурсивных процедур) , `Copyright...` и некоторые другие.

• description – служебное слово, за которым следуют комментарии 
descriptionSequence о назначении процедуры и ее работе (одна или несколько строк). 
В отличие от комментариев, задаваемых символом #, данная информация 
выводится на экран при печати кода процедуры.

•uses – служебное слово для описания последовательности usesSequence связанных 
имен и модулей, которые будут использованы в теле процедуры. Может быть 
использовано для подключения пакетов, например: uses StringTools;



Примеры процедур: обязательные аргументы, количество аргументов 
при вызове процедуры, декларирование типов аргументов
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Примеры процедур: декларирование типов аргументов, несколько 
типов данных, значения по умолчанию
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Примеры процедур: описатели option, description, uses



Возврат нескольких значений из процедуры
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Вывод кода пользовательской процедуры на экран

 print(proc_name);

 eval(proc_name);

Вывод кода процедуры на экран
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Вывод кода процедуры из библиотеки Maple на экран
(кроме встроенных процедур, с опцией builtin)

 interface(‘verboseproc’=2): print(proc_name);

 interface(‘verboseproc’=2): eval(proc_name);

11

Вывод кода процедуры на экран (продолжение)



Локальные и глобальные переменные: 
декларирование локальных переменных
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Локальные и глобальные переменные: 
декларирование локальных переменных
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Различие между локальными и глобальными 
переменными
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 _passed – последовательность всех аргументов, переданных 
процедуре при ее вызове (устаревший вариант: args), имеет тип 
exprseq

 _npassed – число всех аргументов, переданных процедуре при ее 
вызове (устаревший вариант: nargs)

Работа с аргументами процедуры: параметры _passed 
и _npassed для всех переданных аргументов
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Если при вызове процедуры число переданных аргументов больше числа 
обязательных, то можно получить доступ к оставшимся «лишним» аргументам:

 _rest – последовательность «лишних» аргументов, переданных процедуре при 
ее вызове, имеет тип exprseq

 _nrest – число «лишних» аргументов, переданных процедуре при ее вызове

Работа с аргументами процедуры: параметры 
_rest и _nrest для «лишних» аргументов 
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Рекурсивные процедуры: опция remember
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Опция remember сокращает время работы рекурсивной процедуры



   error “Message %1….String…%2….”,par1,par2,…
В строке сообщения об ошибке вместо %1 подставляется значение 
par1, вместо %2 подставляется значение par2 и т. д.

Вывод пользовательского сообщения об ошибке и 
аварийный выход из процедуры
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При выполнении команды error  
все оставшиеся команды в теле 
процедуры игнорируются.



Выход из процедуры в любом месте ее тела и возврат 
значений
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  return exp1,expr2,…

При выполнении команды return  
все оставшиеся команды в теле 
процедуры игнорируются.



Обобщение процедур

➢ Модули
➢ Макроопределения alias и macro
➢ Создание пакетов и библиотек



 Модуль – это обобщение процедуры. Процедура позволяет создать 
команду из последовательности Maple-команд.  С помощью модуля 
можно создать более сложную структуру, включающую набор 
процедур и данных.  Модуль позволяет экспортировать переменные

Полный синтаксис модуля
 module() 

 export eseq; 
 local lseq; 
 global gseq; 
 option optseq; 
 description dseq;
 uses usesSequence; 
 statementSequence

 end module

 Описатель export задает имена процедур и переменных, доступных 
для вызова

 Остальные описатели аналогичны соответствующим описателям в 
процедуре

Модуль
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Сравнение модуля и процедуры
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 Процедура

 Модуль

 Обращение к экспортируемым объектам модуля – с помощью 
команды :-



Новые имена для уже существующих функций

 alias(e1, e2, ..., eN) – аббревиатуры для имен и функций, где ei имеют 
вид new=old

 Нельзя определить одну аббревиатуру alias через другую

Макроопределения: alias
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Макросы

 macro(e1, e2, ..., eN) – макро-абрревиатуры для имен и функций, 
где ei имеют вид new=old

 Можно использовать для переопределения имеющихся команд

Макроопределения: macro
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 Пакет – это набор пользовательских процедур для решения задач 
определенного класса. 

Сначала создаются и тестируются процедуры для пакета. Созданный пакет 
нужно сохранить в виде .m-файла

 save pack_name, “filename.m” – сохранение пакета pack_name в файл 
 read “filename.m” – чтение файла с пакетом с диска
 with(pack_name) – подключение пакета

 

Создание пакетов
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 Библиотека – это набор пользовательских процедур и пакетов. 

Сначала нужно создать файл для библиотеки и сохранить путь к нему. Затем задать 
(подключить) пакеты, процедуры, модули.

 march – команда для работы с файлами библиотек
 savelibname – переменная с сохраненным путем к библиотеке

 savelib(name1,name2,..) – сохранение пакетов и процедур в библиотеку
 libname – переменная с путем к библиотеке

Создание библиотек
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Работа с файлами. 
Команды ввода и вывода

➢ Команды для работы с файлами
➢ Сохранение в файл 
➢ Запись в файл
➢ Чтение из файла



 save name1, name2, ..., namek, fileName.ext – сохранение переменных 
в файл fileName (расширение .m – внутренний формат Maple, можно 
указать другое)

Открытие файла

 open(“fileName.ext”,mode) – открытие файла (без буферизации), в 
качестве mode можно указать READ или WRITE

 fopen(“fileName.ext”,mode,type) – открытие файла (c буферизацией) , 
в качестве mode можно указать READ, WRITE или APPEND, в качестве 
type – BINARY или TEXT

Чтение из файла

 read fileName.ext – чтение информации из файла filename

 readdata(fileID, format, n) – чтение числовой информации в заданном 
формате из файла

 readline(“fileName.ext”) – чтение следующей строки из заданного 
файла

Работа с файлами

28



Запись в файл

 writeto(“fileName.ext”) – запись всех последующих команд в файл, 

 appendto (“fileName.ext”) – добавление команд без перезаписи 
содержимого; 

 writeto(terminal) – возврат к записи на экран

 writedata(fileID, data, format) – запись числовой информации в файл в 
заданном формате

 writeline(“fileName.ext”, str ...) – запись строк в файл 

 fprintf(file, fmt, x1, ..., xn) – форматированная запись в файл

Закрытие файла

 fclose(file ...) – закрытие файла без буферизации

 close(file ...) – закрытие файла c буферизацией

Работа с файлами: продолжение
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Сохранение переменной в файл: 
использование команды save
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 file.m – файл внутреннего формата Maple



Запись в файл и на экран: использование команды 
writeto
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Установка рабочей директории

 currentdir() – вывод на экран пути к каталогу с файлом (текущая 
рабочая директори)

 currentdir(dirName) – задание нового пути к каталогу с файлом

Содержимое файла myfile.mw будет перезаписано



Чтение числовой информации из текстового 
файла
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 readdata(fileID, format, n) – чтение числовой информации
 fileID – описатель файла (переменная)
 n - число колонок  в файле с данными, колонки должны быть разделены 

пробелами
 format – формат данных integer, float, string или список этих типов



Запись числовой информации в текстовый файл
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 writedata(fileID, data)

 writedata(fileID, data, format)
 fileID – описатель файла (переменная)
 data - список, вектор или матрица
 format – формат данных integer, float, string или список этих типов



Чтение строк из текстового файла: использование 
команды readline
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Запись строк в текстовый файл: использование команд 
writeline и fprintf
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fprintf(file, fmt, x1, ..., xn) – запись выражений в файл на основе заданного 
формата строки
Некоторые форматы:
d – целое, f – с плавающей точкой



Maplets

➢ Maplets – графические приложения пользователя
➢ Создание Maplets с помощью Maplet Builder
➢ Создание Maplets с помощью команд пакета Maplets



Общие сведения о Maplet
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 Maplet – графическое приложение пользователя, созданное с 
помощью команд Maple

 Maplet можно создать

 С помощью ассистента Maplet Builder (Tools->Assistants->Maplet Builder)

 С помощью команд пакета Maplets

 Maplet можно запустить в командной строке Maple или с помощью
отдельного  приложения Maple MapletLauncher

Пример простого maplet, который выводит сообщение “Hello World”



Пример создания maplet с помощью Maplet
Builder: функция и ее график
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 Готовый maplet: в поле ввода пользователь вводит функцию одной 
переменной, при нажатии на кнопку Plot в поле вывода появляется 
график функции 



Создание maplet с помощью Maplet Builder

39

 Tools->Assistants->Maplet Builder

В пустом maplet

1 колонка и 0 

строк

 Создание maplet начинается с задания числа полей (элементов) и 
их графического расположения



Элементы (поля) maplet 
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 Для создания этого maplet было использовано 4 элемента:

Plotter

Button

Text Field

Label



Пример создания maplet с помощью Maplet
Builder: шаг 1
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 Шаг 1: задать число строк в maplet: в имеющейся первой колонке – 2 
строки



Пример создания maplet с помощью Maplet
Builder: шаг 2
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 Шаг 2: добавить элемент plotter в первую строку

 Как удалить элемент: выделить и нажать Del на клавиатуре 



Пример создания maplet с помощью Maplet
Builder: шаг 3
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 Шаг 3: добавить 3 колонки во вторую строку



Пример создания maplet с помощью Maplet
Builder: шаг 4
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 Шаг 4: добавить элемент label во вторую строку



Пример создания maplet с помощью Maplet
Builder: шаг 5
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 Шаг 5: добавить элемент текстового поля (Text Field) во вторую 
строку



Пример создания maplet с помощью Maplet
Builder: шаг 6
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 Шаг 6: добавить элемент button во вторую строку



Пример создания maplet с помощью Maplet
Builder: шаги 7 и 8
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 Шаг 7: в открывающемся окне Evaluate Expression задать

 Шаг 8: Запуск приложения: File->Run (будет предложено 
сохранить Maplet)



Пример создания maplet с помощью команд пакета Maplets: 
функция и ее график
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Подпакеты пакета Maplets: 
• Elements
• Tools
• Utilities



Запуск созданного maplet с помощью команды Display 
пакета Maplets
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Результат
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